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Preface 

This Preface introduces the guides and other information sources available to help 

you more effectively use Oracle Fusion Applications. 

Disclaimer 

The information contained in this document is intended to outline our general 

product direction and is for informational sharing purposes only, and should be 

considered in your capacity as a customer advisory board member or pursuant to 

your beta trial agreement only. It is not a commitment to deliver any material, code, 

or functionality, and should not be relied upon in making purchasing decisions. The 

development, release, and timing of any features or functionality described in this 

document remains at the sole discretion of Oracle. This document in any form, 

software or printed matter, contains proprietary information that is the exclusive 

property of Oracle. Your access to and use of this confidential material is subject to 

the terms and conditions of your Oracle software license and service agreement, 

which has been executed and with which you agree to comply. This document and 

information contained herein may not be disclosed, copied, reproduced or 

distributed to anyone outside Oracle without prior written consent of Oracle. This 

document is not part of your license agreement nor can it be incorporated into any 

contractual agreement with Oracle or its subsidiaries or affiliates. 

Other Information Sources 

My Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For 

information, visit http://www.oracle.com/support/contact.html or visit 

http://www.oracle.com/accessibility/support.html if you are hearing impaired. 

Use the My Oracle Support Knowledge Browser to find documents for a product 

area. You can search for release-specific information, such as patches, alerts, white 

papers, and troubleshooting tips. Other services include health checks, guided 

lifecycle advice, and direct contact with industry experts through the My Oracle 

Support Community. 
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Oracle Enterprise Repository 

Oracle Enterprise Repository provides visibility into service-oriented architecture 

assets to help you manage the lifecycle of your software from planning through 

implementation, testing, production, and changes. In Oracle Fusion Applications, 

you can use the Oracle Enterprise Repository for: 

• Technical information about integrating with other applications, including 

services, operations, composites, events, and integration tables. The 

classification scheme shows the scenarios in which you use the assets, and 

includes diagrams, schematics, and links to other technical documentation. 

• Publishing other technical information such as reusable components, policies, 

architecture diagrams, and topology diagrams. 

The Oracle Fusion Applications information is provided as a solution pack that you 

can upload to your own deployment of Oracle Enterprise Repository. You can 

document and govern integration interface assets provided by Oracle with other 

assets in your environment in a common repository. 

Documentation Accessibility 

For information about Oracle’s commitment to accessibility, visit the Oracle 

Accessibility Program website at http://www.oracle.com/us/corporate/accessibility 

/index.html. 

Comments and Suggestions 

Your comments are important to us. We encourage you to send us feedback about 

Oracle Fusion Applications Help and guides. Please send your suggestions to 

oracle_fusion_applications_help_ww@oracle.com. You can use the Send Feedback 

to Oracle link in the footer of Oracle Fusion Applications Help.  

 

 



 

 Introduction 1-1 

1 

Introduction 

Oracle Governance, Risk and Compliance (GRC) is a set of products that regulate 

activity in business-management applications. This document provides instructions 

for the installation (or upgrade) of the following GRC products: 

• Oracle Enterprise Governance, Risk and Compliance Manager (EGRCM) 

consists of loosely coupled functional modules that collectively manage an 

organization’s governance, risk, and compliance objectives.  

• Oracle Fusion GRC Intelligence (GRCI) extracts data from EGRCM for display 

in dashboards and reports.  

You can install EGRCM on its own, or to be integrated with an OID LDAP server 

that manages EGRCM users. (OID stands for Oracle Internet Directory; LDAP for 

Lightweight Directory Access Protocol.) In either case, you can embed a GRCI 

instance within EGRCM. (You would not install GRCI on its own, because its pur-

pose is to provide dashboard and reporting capability to EGRCM.) If you intend to 

use GRCI, complete the installation of EGRCM first (see Chapter 2). Then integrate 

GRCI with EGRCM (see Chapter 3).  

As you implement GRC, keep the following in mind: 

• You cannot use GRC release 8.6.4 to install a third GRC product — Enterprise 

Governance, Risk and Compliance Controls (EGRCC). If you wish to install 

EGRCC, use GRC release 8.6.3. 

• You can install GRC on a server that you own and maintain (a “conventional” 

installation), or you can use Oracle VM Server to deploy an image of GRC in-

itially configured by Oracle. 

Prerequisites 

If you intend to deploy a VM image of GRC, you need to install Oracle VM Mana-

ger and Oracle VM Server 2.2, and the remaining prerequisites do not apply to you. 
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If you intend to perform a conventional GRC installation, then EGRCM and GRCI 

run on a 64-bit Linux server. For an installation on Linux, be sure the following lines 

exist in the /etc/security/limits.conf file: 

*    soft    nproc     8192 

*    hard    nproc     32768 

*    soft    nofile    65536 

*    hard    nofile    131072 

If you are installing on Solaris, set the following configuration parameter in 

/etc/system to protect against exploitation of buffer overflow attacks. (There is no 

need to do this for OEL or other Linux variations.) 

noexec_user_stack = 1 

The installation of Governance, Risk and Compliance requires that the following also 

be installed: 

• Oracle database 11g Release 2. See “Creating GRC and DA Schemas,” below. 

• Java: Sun Java Development Kit 1.6 or higher. JRockit JDK R28.1.3 for Java 

SE 6 with JRockit Mission Control 4.0.1 for Linux x86-64 is also supported. 

GRC must have its own dedicated Java container. It was not designed to coexist 

in a container with other web applications. 

• Middleware: EGRCM requires WebLogic Server (WLS) and related components 

— some combination of Service Oriented Architecture (SOA), Repository Crea-

tion Utility (RCU), and Application Development Runtime (ADR).  

Install EGRCM with SOA if you intend to integrate with other applications and 

want them to consume SOA worklists. In this case, you need WLS 10.3.5, SOA 

11.1.1.5, and  RCU 11.1.1.5. 

Otherwise, install EGRCM without SOA. In this case, you need WLS 10.3.5 

and ADR 11.1.1.5. (You can use EGRCM with a SOA instance you’ve already 

installed for other purposes. In that case, install the same middleware compo-

nents you would if you were installing EGRCM without SOA.)  

If you intend to run GRCI as well as EGRCM, use middleware components 

already installed for EGRCM. In this case, however, you need RCU 11.1.1.5 

even if you’ve installed EGRCM without SOA (or to run with a pre-existing 

SOA instance).  

Subsequent chapters cover download, installation, and configuration of 

middleware components.  

• An OID LDAP server, if you intend to install EGRCM so that its users are 

managed by such a server.  

On the server or a client system, either of the following web browsers can display 

the EGRCM interface: 

• FireFox 3.6.1 

• Microsoft Internet Explorer 8, with the Adobe SVG plugin available from 

http://www.adobe.com/svg/viewer/install/mainframed.html. 

For details about supported components, see the Oracle Governance, Risk and 

Compliance Applications Support Matrix. 
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Creating GRC and DA Schemas 

In the Oracle database, create a GRC schema for use by EGRCM. If you intend also 

to install GRCI, create a second schema, known as the Data Analytics (DA) schema. 

The following is a sample script that serves for the creation of either schema. You 

are assumed to have created tablespaces; each schema requires its own. The values 

you choose for tablespace name, user (schema) name, and password would be dis-

tinct for each schema, and are represented here by TablespaceName, UserName, 

and UserPassword, respectively. 

create user UserName identified by UserPassword default 

tablespace TablespaceName quota unlimited on TablespaceName 

quota 0k on system; 

grant connect, resource to UserName; 

grant create any view to UserName; 

grant create any table to UserName; 

grant drop any table to UserName; 

Run the following commands as the system user: 

ALTER SYSTEM SET open_cursors=5000; 

ALTER SYSTEM SET processes=3000 scope=spfile; 

ALTER SYSTEM SET sessions=3000 scope=spfile; 

ALTER SYSTEM SET deferred_segment_creation=FALSE; 

After running these commands, bounce the database.  

GRC may display information in any of twelve languages. To use the multilingual 

capabilities of GRC, be sure the database that hosts the GRC schema is set up for 

UTF-8 encoding. To do so, execute this command: 

SELECT value$ FROM sys.props$ WHERE name = 'NLS_CHARACTERSET' ; 

The return value should be AL32UTF8.  
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Installing EGRCM 

To perform a conventional GRC installation, use procedures in this chapter. If you 

intend to deploy a VM image of GRC, ignore this chapter and skip to Chapter 4. 

For a conventional installation, decide if you are installing EGRCM with SOA (yes 

if you are integrating with other applications that will consume SOA worklists, and 

have no existing SOA installation; otherwise, no).  

Then complete the appropriate one of the following procedures. (Summary proce-

dures appear here, with details given in later sections of this chapter.)  

If you are installing EGRCM with SOA: 

1. Download files to the GRC server and prepare them for use, and create a direc-

tory for the storage of EGRCM report data.  

2. Install WebLogic Server and other components — Repository Creation Utility 

(RCU) and Service Oriented Architecture (SOA).  

3. Create a WebLogic domain. This entails setting up an Administration Server 

and a “managed server” for SOA. Within the domain, install “SOA composites” 

and “keystores,” set up security credentials, enable “embedded LDAP,” and create 

a soaadmin user. 

4. If you intend to install EGRCM so that an OID LDAP repository manages its 

users, configure that repository. 

5. Perform configuration steps in a WebLogic Server Administration Console, and 

modify memory and other settings to conform to GRC requirements. 

6. Perform configuration steps in a GRC Manage Application Configurations page. 

7. Run WebLogic to complete the installation. 

If you are installing EGRCM to be used without SOA, or to be used with an already 

existing SOA instance: 

1. Download files to the GRC server and prepare them for use, and create a direc-

tory for the storage of EGRCM report data.  

2. Install WebLogic Server and Application Development Runtime.  

3. Create a WebLogic domain. This entails setting up an Administration Server 

(but no managed server).  
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4. If you intend to install EGRCM so that an OID LDAP repository manages its 

users, configure that repository. 

5. For EGRCM with a pre-existing SOA Server, configure “SOA composites” and 

“keystores,” set up security credentials, enable “embedded LDAP,” and create a 

soaadmin user for that server. (For EGRCM without SOA, skip this step.) 

6. Perform configuration steps in a WebLogic Server Administration Console, and 

modify memory and other settings to conform to GRC requirements. 

7. Perform configuration steps in a GRC Manage Application Configurations page. 

8. Run WebLogic to complete the installation. 

Downloading Files  

Create a staging directory on your GRC server. (Throughout this document, 

<grc_stage> represents the full path to this directory.)  

To install EGRCM, download a file called grc_864.zip to <grc_stage>, and extract 

its contents there. To validate your download, generate a checksum and compare it 

with a checksum value published in Release Notes for the instance you are instal-

ling. To generate a checksum, run the command md5sum grc.ear. 

If you expect to use GRCI within EGRCM, download a second file called 

grc864_obiee.zip to <grc_stage>. See Chapter 3 for instructions on the use of this 

file. 

You need middleware components appropriate for the installation you will perform. 

These are available on E-Delivery. Middleware components include some combina-

tion of the following (see “Prerequisites” on page 1-1):  

• Oracle Weblogic Server 11gR1 (10.3.5) Generic and Coherence 

• Oracle SOA Suite 11gR1 (11.1.1.5.0) 

• Oracle Repository Creation Utility (11.1.1.5.0) for Linux x86 

• Oracle Application Development Runtime (11.1.1.5.0).  

Creating a Report Repository 

Create a “Report Repository” — a directory that stores copies of GRC reports that 

users schedule to be run. Note the path to the Report Repository, as you will need to 

supply it later as a configuration value. The Repository can reside on an NFS mount 

or any valid directory to which the user running WebLogic has full permissions. 

Setting Up WebLogic 

Install WebLogic Server (WLS) and related components generally as their documen-

tation instructs you to do. You will need to make choices that support their use with 

GRC. Complete procedures, documented from here to page 2-12, that are appropriate 

to the installation you are performing (EGRCM with or without SOA). Then continue 

at “EGRCM Configuration” on page 2-13.  
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Initial WebLogic Installation 

Ensure that Sun JDK 1.6 is in the path to install and run WebLogic Server. Then 

install WLS as a Standard Default Deployment. 

Next, if you are installing EGRCM with SOA, complete these procedures: 

1. Install Repository Creation Utility (RCU). These RCU components are required:  

• Metadata Services (MDS schema) 

• SOA Infrastructure (SOAINFRA schema) 

• Business Activity Monitoring (ORABAM schema) 

• User Messaging Service (ORASDPM schema) 

2. Once RCU is installed, run it to install SOA schemas: 

a. Set an XEDB environment variable to provide connection information for 

your EGRCM database. Enter the following: 

export XEDB=Dbhost:Dbport:SID 

Replace Dbhost with the fully qualified domain name (FQDN) of your 

EGRCM database server, Dbport with the port number at which the database 

communicates with other applications, and SID with the service identifier 

value configured for the database in the tnsnames.ora file.  

b. Use the createRepository option in RCU to create repositories. Navigate to 

<RCU_HOME>/bin (in which <RCU_HOME> represents the highest-level 

directory in which RCU components exist). Then execute this command:  

./rcu -silent -createRepository -connectString $XEDB 

-dbUser sys -dbRole sysdba -lockSchemas false 

-schemaPrefix EGRCM -component SOAINFRA -component MDS 

-component ORASDPM -component BAM 

As you run the script, you will be prompted to create passwords for each of 

SOAINFRA, MDS, ORASDPM, and BAM.  

3. Install Oracle SOA Suite. Enter the value “soa” as the Oracle Home Directory 

on the Specify Installation Location screen. 

If you are installing EGRCM without SOA install ADR. Do not install either RCU 

or SOA.  

Creating a WebLogic Domain 

For any installation, create a new WebLogic domain. To do so, execute the follow-

ing command:  

<MW_HOME>\wlserver_10.3\common\bin\config.sh 

Note: <MW_HOME> represents the full path to the home directory of your middle-

ware installation — the highest-level directory in which Fusion Middleware com-

ponents exist, including WebLogic. 
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The config.sh script runs a Fusion Middleware Configuration Wizard, which 

prompts you to complete several steps: 

1. Select templates.  

For any installation, one template is selected automatically: “Base WebLogic 

Server Domain — 10.3.5.0.” Also select “Oracle Enterprise Manager — 

11.1.1.0.” When you do, a third template, “Oracle JRF — 11.1.1.0,” is selected 

with it. 

Only if you are installing EGRCM with SOA, select three more templates: 

“Oracle SOA Suite — 11.1.1.0,” “Oracle WSM Policy Manager — 11.1.1.0,” 

and “Oracle JRF Webservices Asynchronous Services — 11.1.1.0.” 

2. Create a name for your WebLogic domain. Use any name you wish. (Throughout 

this document, the value <grc_domain> represents the name you configure here.) 

In two other fields — Domain Location and Application Location — accept 

default values. 

3. At a Configure Administrator Username Password prompt, create a WebLogic 

Server username and password.  

4. At a Configure Server Start Mode and JDK prompt, select “Production Mode.” 

In the JDK Selection area, ensure that the correct JDK is selected. (This is the 

JDK instance you confirmed to be in the path to install and run WebLogic under 

“Initial WebLogic Installation” on page 2-3.) If necessary, use the “Other JDK” 

option to browse. 

5. For EGRCM with SOA only, respond to a Configure JDBC Component Schema 

prompt. Enter details you’ve already established as you used RCU to create 

repositories (see step 2b of “Initial WebLogic Installation” on page 2-3). When 

you complete this step, you should see the value “Test Successful” at a Test 

Component Schema prompt. 

6. For any installation, select “Administration Server” at a Select Optional Con-

figuration prompt. Also select “Managed Servers, Clusters and Machines” if 

you are installing EGRCM with SOA, but not if you are installing EGRCM to 

run with a pre-existing SOA or without SOA. 

7. At a Configure the Administration Server prompt, enter the IP address of the 

machine running the WebLogic Server. Also select an unused port for it. 

8. If you are installing EGRCM with SOA, a Configure Managed Servers prompt 

appears. Confirm that the Configure Managed Servers prompt displays a row 

for a SOA Server. This row appears as a result of EGRCM-specific configura-

tion you’ve already completed. Note the IP address and port, which you’ll need 

to enter later in an EGRCM Worklist page. Continue at step 9. 

If you are installing EGRCM without SOA, or to run with a pre-existing SOA, 

you need not create a managed server. The Configure Managed Servers page and 

several other Configuration Wizard pages do not appear. Skip ahead to step 12. 

9. Skip the Configure Clusters page. 

10. In a Configure Machines page, select the Unix Machine tab. Click Add. Assign 

any name, and accept defaults for all other fields. 
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11. In the Assign Servers to Machines page, select the servers listed in the left box. 

Move them to machine you created in step 10, which is listed in the right box. 

12. In the Summary page, select Create. 

Preparing Additional Files 

Complete these additional steps when the config.sh script finishes running: 

1. Copy the following files from <MW_HOME>\oracle_common\modules\ 

oracle.adf.model_11.1.1, to <MW_HOME>\user_projects\domains\<grc_domain>\lib: 

• adfm.jar 

• adfdt_common.jar 

• adfmweb.jar 

2. Copy the following files from <grc_stage>/lib to <MW_HOME>\user-projects\ 

domains\<grc_domain>\lib: 

• groovy-all-1.6.3.jar 

• xdoparser-10.1.3.4.jar 

3. Copy the file ojdbc6dms.jar from <grc_stage>/lib to <MW_HOME>/oracle_ 

common/modules/oracle.jdbc_11.1.1. (This copy operation will overwrite an 

existing file.) 

4. Create a directory called grc864 (for example, <MW_HOME>/grc864). This 

directory should be entirely distinct from the <grc_stage> directory you created 

as you downloaded GRC files. 

5. Navigate to <grc_stage>/dist, and locate the file grc.ear. Copy it to the grc864 

directory, and extract its contents there.  

6. Look in the directory grc864\WEB-INF\lib to see if the files bicmn-10.1.3.4.jar, 

geronimo-stax-api_1.0_spec-1.0.1.jar, and xdoparser-10.1.3.4.jar exist there. If 

so, delete them. 

Configuring External OID LDAP 

This section applies to you only if you intend to install EGRCM so that an external 

OID LDAP repository manages its users. If you do not, ignore this section and skip 

ahead to “Installing SOA Composites” on page 2-8. If you do, complete these steps: 

1. Log in to the WebLogic Server Administration Console: 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-4.) 

2. Click on the “Security Realms” link in your application’s Security Settings. 

3. Click on the “myrealm” link in the table. 

4. Click on the “Providers” tab. 
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5. Click on the New button and enter the following values: 

• Name: OIDAuthenticator 

• Type: OracleInternetDirectoryAuthenticator 

6. Click on the “OIDAuthenticator” link and then click on the “Provider Specific” 

tab. 

7. Supply values for properties in the “Provider Specific” screen. (Italicized entries 

are literal values, to be entered as they are shown.) 

• Host: The FQDN of the LDAP provider (your OID instance). 

• Port: The port number at which the host communicates with other applica-

tions. 

• Principal: The username for the OID administrative user, preceded by cn=. 

• Credentials: The password configured for the OID administrative user. 

• SSLEnabled: Leave this box unchecked. 

• User Base DN: The LDAP path to the store for user information. For example: 

cn=FusionUsers,cn=users,dc=us,dc=oracle,dc=com 

• All User Filter: (&(cn=*)(objectclass=person)) 

• User From Name Filter: (&(cn=%u)(objectclass=person)) 

• User Search Scope: subtree 

• User Name Attribute: cn 

• User Object Class: person 

• Use Retrieved User Name as Principal: Select this checkbox. 

• Group Base DN: The LDAP path to the store for group (enterprise role) 

information. For example: cn=FusionGroups,cn=groups,dc=us,dc=oracle, 

dc=com 

• All Groups Filter: (&(cn=*)(|(objectclass=groupofUniqueNames) 

(objectclass=orcldynamicgroup))) 

• Group From Name Filter: (|(&(cn=%g)(objectclass=groupofUniqueNames)) 

(&(cn=%g)(objectclass=orcldynamicgroup))) 

• Group Search Scope: subtree 

• Group Membership Searching: unlimited 

• Static Group Name Attribute: cn 

• Static Group Object Class: groupofuniquenames 

• Static Member DN Attribute: uniquemember 

• Static Group DN from Member DN filter: (&(uniquemember=%M)(objectclass= 

groupofuniquenames)) 

• Dynamic Group Name Attribute: cn 

• Dynamic Group Object Class: orcldynamicgroup 
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• Dynamic Member URL Attribute: labeleduri 

• User Dynamic Group DN Attribute: Leave this field blank. 

• Connection Pool Size: 6 

• Connect Timeout: 0 

• Connection Retry Limit: 1 

• Parallel Connect Delay: 0 

• Results Time Limit: 0 

• Keep Alive Enabled: Leave this box unchecked. 

• Follow Referrals: Select this checkbox. 

• Bind Anonymously On Referrals: Leave this box unchecked. 

• Propagate Cause For Login Exception: Leave this box unchecked. 

• Cache Enabled: Select this checkbox. 

• Cache Size: 32 

• Cache TTL: 60 

• GUID Attribute: orclguid 

8. Save your settings, then click on “Activate Changes” on the left, topmost panel. 

9. Click the “OIDAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

10. Click the “DefaultAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

11. Click the Reorder button. Select “OIDAuthenticator” from the available provid-

ers, and move it to the top. To do so, click on the arrow on the right side, then 

click OK. 

12. Click on “Activate Changes” from the Change Center, then log out. 

13. Stop the WebLogic Administration Server and, if one is installed, the SOA 

Server. (If you are installing EGRCM with SOA, the latter is the managed 

server discussed in step 8 of “Creating a WebLogic Domain,” page 2-4. If you 

are installing EGRCM to run with a pre-existing SOA instance, this is the SOA 

server created for that instance.) 

14. Edit boot.properties files. There are two possibilities: 

• GRC, OID LDAP, and (if applicable to you) SOA components exist on one 

instance of WebLogic Server (WLS). If so, up to two boot.properties files 

may exist, one for the Administration Server and (if you use SOA) one for 

the SOA Server. 

In this case, edit each file to set a username value equal to your OID 

administrative user name — the “Principal” in step 7 on page 2-6, without 

the cn= prefix. Set a password value equal to that user’s password — the 

“Credentials” value in step 7 on page 2-6. 

• GRC and OID LDAP exist on distinct instances of WLS. If so, SOA may be 

installed on either WLS instance (or is not installed at all, if you choose not 

to use it). In this case, two or three boot.properties files exist, for the GRC 
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Administration Server on the GRC instance of WLS, for the OID Administra-

tion Server on the OID LDAP instance of WLS, and (if you use SOA) the 

SOA Server on either WLS instance. 

In this case, edit boot.properties files on the OID LDAP instance of WLS to 

set the username and password values equal to those for the OID adminis-

trative user (as defined earlier in this step). Edit boot.properties files on the 

GRC instance of WLS to set the username and password values to those 

you created in step 3 of “Creating a WebLogic Domain” (page 2-4). 

The boot.properties files exist in these locations:  

• For the Administration Server, navigate to <MW_HOME>/user_projects_ 

domains/<grc_domain>/servers/AdminServer/security/boot.properties 

• For the SOA Server (if you have installed one), navigate to <MW_HOME>/ 

user_projects_domains/<grc_domain>/servers/<SoaServerName>/security/ 

boot.properties 

15. Start the Administration Server and SOA Server.  Check whether LDAP is con-

figured successfully: Log in to the WebLogic console (see step 1 of “Configur-

ing External OID LDAP” on page 2-5), go to Security Realms → myRealm, and 

click on Users and Groups. You should see your LDAP users and groups.  

Installing SOA Composites 

If you are installing EGRCM with SOA, or to run with a pre-existing SOA, create 

“SOA composites.” (If you are installing EGRCM without SOA, this does not apply; 

skip ahead to “WebLogic Console Configuration” on page 2-11.) 

1. Ensure that the Administration Server and SOA Server are running. (If you are 

installing EGRCM with SOA, the latter is the managed server discussed in step 

8 of “Creating a WebLogic Domain,” page 2-4. If you are installing EGRCM to 

run with a pre-existing SOA instance, this is the SOA server created for that 

instance.) 

2. Create a temporary folder. (Throughout this section, <temp> represents the full 

path to this folder.) 

3. Locate the file grc-soa-composite-8.6.4-SNAPSHOT-package.zip in <grc_stage>/dist. 

Extract its contents in <temp>. 

4. Edit the file <temp>/grc-soa-composite_cfgplan.xml: Search for the value 

GrcServerHostName or <GrcServerHostName> and replace it with the FQDN of 

your GRC server. Search for the value ServerPortNumber or <ServerPortNumber> 

and replace it with the number you selected for the WebLogic Administration Server. 

(See step 7 of “Creating a WebLogic Domain” on page 2-4.) 

5. Access Enterprise Manager (EM) at: 

http://host:port/em 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server.  

6. Select “Archive on the server where Enterprise Manager is running” under Archive or 

Exploded Directory. Point it to <temp>/grc-soa-composite_cfgplan.xml. Click Next. 

7. Click Deploy on the Confirmation page.  
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8. When you receive confirmation that deployment is successful, hit the following 

URL, in which host is the FQDN of your GRC server and soa_port is the port 

configured for your SOA Server: 

http://host:soa_port/soa-infra/services/default/ 

GrcSoaComposite/GrcService 

If you need to deploy composites again at a later point, first undeploy composites, 

then use the procedure defined above to deploy again. To undeploy composites: 

1. Log on to Enterprise Manager (see step 5 above). 

2. Under your domain, navigate to SOA → soa_infra → GrcSoa Composite. Right 

click SOA Deployment → Undeploy.  

3. Click Undeploy.  

Creating Keystores 

If you are installing EGRCM with SOA, or to run with a pre-existing SOA, create 

“keystores” once SOA composites exist. (If you are installing EGRCM without SOA, 

this does not apply; skip ahead to “WebLogic Console Configuration” on page 2-11.) 

1. Stop the (newly created or pre-existing) SOA Server and the Administration Server. 

2. Use keytool to set up your keystore. (Keytool is located in <Java_Home>/bin, 

where <Java_Home> represents the highest-level directory in which Java com-

ponents are installed.) Execute the following command: 

./keytool -genkeypair -alias orakey -keyalg "RSA" -keystore 

default-keystore.jks -validity 3600 

3. When prompted, designate a keystore password and a key password. This cre-

ates a keystore called default-keystore.jks, and a key pair with the alias orakey 

within that keystore.  

4. Move the new keystore to a directory called fmwconfig. Execute this command: 

mv default-keystore.jks <MW_HOME>/user_projects/domains/ 

<grc_domain>/config/fmwconfig 

This overwrites a pre-existing default-keystore.jks file.  

5. Start the Administration Server and the SOA Server. 

Setting Up Credentials 

If you are installing EGRCM with SOA, or to run with a pre-existing SOA, use 

Enterprise Manager (EM) to set up credentials once keystores are created. (If you 

are installing EGRCM without SOA, this does not apply; skip ahead to “WebLogic 

Console Configuration” on page 2-11.) 

1. Access EM at 

http://host:port/em 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-4.) 
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2. Click on Weblogic Domain → <grc_domain>. 

3. Right-click on the <grc_domain> and select Security → Credentials. 

4. On the Credentials page, click on the button labeled + Create Map. Enter 

oracle.wsm.security as Map Name, and click OK. A new row, oracle.wsm.security, 

is created. 

5. Add keys to the wallet. For each key, click the button labeled + Create Key, 

then supply the following values in response to prompts: 

• basic.credentials (this contains user authentication) 

– Select Map: oracle.wsm.security 

– Key: basic.credentials 

– Type: Password 

– Username: weblogic 

– Password: weblogic 

– Description: User credentials key 

• keystore-csf-key 

– Select Map: oracle.wsm.security 

– Key: keystore-csf-key 

– Type: Password 

– Username: owsm 

– Password: Enter the keystore password you created in step 3 of 

“Creating Keystores” (page 2-9). 

– Description: Keystore key 

• enc-csf-key 

– Select Map: oracle.wsm.security 

– Key: enc-csf-key 

– Type: Password 

– Username: orakey 

– Password: Enter the key password you created in step 3 of “Creating 

Keystores” (page 2-9). 

– Description: Encryption key 

• sign-csf-key 

– Select Map: oracle.wsm.security 

– Key: sign-csf-key 

– Type: Password 

– Username: orakey 
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– Password: Enter the key password you created in step3 of “Creating 

Keystores” (page 2-9). 

– Description: Signing key 

When you finish creating credentials, your domain should be running with at least 

the Administration Server and SOA Server. 

Creating the SOA Admin User and Enabling Embedded LDAP 

If you are installing EGRCM with SOA, or to run with a pre-existing SOA, create a 

user called soaadmin and enable Embedded LDAP. (If you are installing EGRCM 

without SOA, this does not apply; skip ahead to “WebLogic Console Configuration,” 

page 2-11.) 

1. Shut down the SOA Server. (If you are installing EGRCM with SOA, this is the 

managed server discussed in step 8 of “Creating a WebLogic Domain,” page 2-4. 

If you are installing EGRCM to run with a pre-existing SOA instance, this is the 

SOA server created for that instance.) 

2. Log in to the WebLogic Server Administration Console at 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-4.) 

3. Click on Security Realms, then myrealm. Click Users and Groups. Click New, 

and enter soaadmin in the Name field. Add a description. Accept “Default 

Authenticator.” Enter a password of your choice in the Password field, and the 

same value in the Confirm Password field. Click Save. 

4. Click on the soaadmin user. Click on the Groups tab, and move the value 

Administrators from Available to Chosen. Then save your settings. 

5. Click on <grc_domain>. Click the Security tab, then Embedded LDAP. Enter 

any value for Credential, and then the same value for Confirm Credential.  

6. Stop and start the Administration Server. 

WebLogic Console Configuration 

For any installation, use the WebLogic Server Administration Console to complete 

additional configuration steps: 

1. Make sure you are logged in to the WebLogic Console (see step 2 of “Creating 

the SOA Admin User and Enabling Embedded LDAP,” above). 

2. In the Change Center pane, click Lock & Edit. 

3. In the Domain Structure pane, click on Deployments. 

4. In the Summary of Deployments pane, select the Control tab. 

5. In the Summary of Deployments pane, click on the Install button. 

6. In the Path field of the Install Application Assistant pane, enter the full path to 

the grc864 directory you created earlier (see step 4 of “Preparing Additional 

Files” on page 2-5). Select “grc864 (open directory)” under Current Location. 
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7. In the Install Application Assistant pane, press next.  

8. In the Install Application Assistant pane, choose “Install this deployment as an 

application” in the “Choose targeting style” section. 

9. In the Install Application Assistant pane, press Next. Then: 

• If you are installing EGRCM with SOA, select the Administration Server.  

• If you are installing EGRCM to run without SOA or with a pre-existing 

SOA, you are not presented with an opportunity to select a server here. Skip 

to step 10. 

10. In the Install Application Assistant pane, choose “I will make this deployment 

accessible from the following location” in the “Source accessibility” section. 

Accept all other defaults. 

11. In the Install Application Assistant pane, press Next. 

12. In the Install Application Assistant pane, choose “Yes, take me to the deploy-

ment’s configuration screen” in the “Additional configuration” section. 

13. In the Install Application Assistant pane, press Finish. 

14. In the Install Application Assistant pane, press Save, then Activate Changes. On 

the Deployments screen, the state of the grc864 application will be “Prepared.”  

15. Select the grc864 application. Click Start, select “Servicing all requests,” and 

wait until the application status changes to “Active.” 

Modifying Settings 

Next, modify settings in a file called setDomainEnv.sh, which is located in the 

<MW_HOME>/user_projects/domains/<grc_domain>/bin directory. 

1. Stop the SOA Server (if you are installing EGRCM with SOA) and the 

Administration Server.  

2. Navigate to setDomainEnv.sh and open it in a text editor.  

3. In the file, locate JAVA_OPTIONS and edit it to include the following: 

-Djbo.ampool.maxpoolsize=600000 

4. In the file, also locate the following lines: 

# IF USER_MEM_ARGS the environment variable is set, use it 

to override ALL MEM_ARGS values 

if [ "${USER_MEM_ARGS}" != "" ] ; then 

Insert the following line between those two lines:  

USER_MEM_ARGS="-Xms4096m –Xmx16384m -XX:PermSize=256m 

-XX:MaxPermSize=512m -Djava.awt.headless=true" 

You may use a maximum memory setting (-Xmx) larger than 16384m if your 

server has enough memory to support the larger value.  

5. Start the Administration Server and (if appropriate) SOA Server. 
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EGRCM Configuration 

In a Manage Application Configurations page, perform GRC-specific configuration: 

1. Access GRC at 

http://host:port/grc 

In this URL, replace host with the FQDN of your GRC server. Enter the port 

number you chose for the Administration Server as you created a WebLogic 

domain. (See step 7 of “Creating a WebLogic Domain” on page 2-4.) 

2. The Manage Application Configurations page appears with a Properties tab 

selected. In the Installation Configuration section, type or select appropriate 

property values: 

• User Name: Supply the user name for the GRC database. 

• Password: Supply the password for the GRC database.  

• Confirm Password: Re-enter the password for the GRC database.  

• Port Number: Supply the port number at which the GRC database server 

communicates with other applications.  

• Service Identifier: Supply the service identifier (SID) for the GRC database 

server, as configured in the tnsnames.ora file. 

• Server Name: Supply the FQDN of the database server.  

• Maximum DB Connections: The recommended value is 50. 

• Report Repository Path: Supply the full path to the Report Repository 

directory discussed in “Creating a Report Repository” on page 2-2.  

• Log Threshold: Select a value that sets the level of detail in log-file entries. 

From least to greatest detail, valid entries are error, warn, info, and debug.  

• App Server Library Path: Enter the full path to the library subdirectory of 

your web application server.  

3. In the Language Preferences section on the Properties tab of the Manage 

Application Configurations page, select the check boxes for up to twelve lan-

guages in which you want GRC to be able to display information to its users. 

4. In the Manage Application Configurations page, click on Actions → Save. GRC 

tests the values you’ve entered and, if they are valid, saves them. (If any are in-

valid, an error message instructs you to re-enter them.) 

5. Exit the Manage Application Configurations page.  

Completing the Installation 

No matter what installation you are performing, you complete the installation in 

effect by running your web application server. If you installed EGRCM with SOA 

(or to run with a pre-existing SOA), or EGRCM to integrate with an OID LDAP 

server, you need to perform additional steps. 
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All Installations 

With components in place and properly configured, complete these steps:  

1. Shut down and then restart the Administration Server. 

2. In a web browser, enter the GRC URL (see step 1 of “EGRCM Configuration,” 

page 2-13). 

3. Wait for a pop-up message to report, “Database upgrade and initialization process 

complete.” Click on its OK button. 

4. You are redirected to a GRC logon page. Log on to the application, using the 

default logon values admin for user ID and admin for password. GRC requires 

you to change the password the first time you log on. 

EGRCM with SOA 

If you installed EGRCM with SOA, or to run with a pre-existing SOA, complete 

these additional steps: 

1. Ensure that the SOA Server is up and running. (If you have installed EGRCM 

with SOA, the SOA Server is the managed server discussed in step 8 of “Creating 

a WebLogic Domain,” page 2-4. If you have installed EGRCM to run with a pre-

existing SOA instance, this is the SOA server created for that instance.) 

2. Log on to EGRCM (see step 1 of “EGRCM Configuration” on page 2-13).  

Select Navigator → Tools → Setup and Administration → Manage Application 

Configurations. 

3. Select the Worklist tab and enter values. Some of these values depend on 

whether you’ve installed EGRCM to integrate with an OID LDAP repository to 

manage users (“LDAP”), or not (“No LDAP”): 

• Worklist Server User Name:  

– No LDAP: Keep the default value, soaadmin.  

– LDAP: Enter the OID/LDAP administrative user name (see step 14 of 

“Configuring External OID LDAP” on page 2-7). 

• Worklist Server Password:  

– No LDAP: Enter the password you created for the soaadmin user (see 

step 3 of “Creating the SOA Admin User and Enabling Embedded 

LDAP” on page 2-11).  

– LDAP: Enter the OID/LDAP administrative user password (see step 14 

of “Configuring External OID LDAP” on page 2-7). 

• Worklist Server Confirm Password: Re-enter the Worklist Server Password. 

• Worklist Server URL: http://host:port, in which host is the IP address of your 

SOA server, and port is its port number.  

• Worklist Server Protocol. Select the communications protocol — either SOAP 

or RMI — used by EGRCM to send and receive SOA requests.  

4. In the Manage Application Configurations page, click on Actions → Save. Then 

log off of EGRCM. 
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5. Stop the GRC Deployment in the WebLogic Console: 

a. Log in to the WebLogic Console at  

http://host:port/console 

Replace host with the FQDN of your GRC server, and port with the number 

you selected for the WebLogic Administration Server. (See step 7 of “Creating 

a WebLogic Domain” on page 2-4.) 

b. From the Domain Structure menu, select Deployments. 

c. From the Deployment page, locate the GRC deployment and verify the state 

is Active. 

d. Click the checkbox next to the GRC deployment. 

e. From the toolbar, click Stop → Force Stop Now. 

6. Start the GRC Deployment in the WebLogic Console: 

a. From the Domain Structure menu, select Deployments. 

b. From the Deployment page, locate the GRC deployment and verify the state 

is Prepared. 

c. Click the checkbox next to the GRC deployment. 

d. From the toolbar, click Start → Servicing All Requests. 

EGRCM with OID LDAP 

If you have installed EGRCM to integrate with an OID LDAP server that manages 

EGRCM users, complete these additional steps: 

1. Log on to EGRCM (see step 1 of “EGRCM Configuration” on page 2-13).  

Select Navigator → Tools → Setup and Administration → Manage Application 

Configurations. 

2. Select the User Integration tab and enter the following values: 

• Enable Integration: Select this check box. 

• User Name: Enter the value you entered for “Principal” in step 7 of “Config-

uring External OID LDAP” (page 2-6). Include the cn= prefix. 

• Password: Enter the value you entered for “Credentials” in step 7 of “Con-

figuring External OID LDAP.” 

• Confirm Password: Re-enter the Password value. 

• Port Number: Enter the value you entered for “Port” in step 7 of “Config-

uring External OID LDAP.” 

• Server Name: Enter the value you entered for “Host” in step 7 of “Config-

uring External OID LDAP.” 

• Bind DN Suffix: Enter the value you entered for “User Base DN” in step 7 

of “Configuring External OID LDAP.” 

• Perform LDAP Recursive Search: Select this check box. 

• Unique User Identifier: uid 

3. In the Manage Application Configurations page, click on Actions → Save. 
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Upgrading EGRCM 

Rather than directly install EGRCM, you can upgrade to it from EGRCM version 

8.6.3.4000 or later. (Upgrade from any earlier EGRCM version is not possible.) To 

upgrade:  

1. Back up the existing EGRCM 8.6.3.4000 deployment. 

2. Delete the existing EGRCM 8.6.3.4000 deployment in WLS. This should leave 

the existing EGRCM schema and data intact. 

3. Ensure you have upgraded version 11.1.1.4.0 middleware components to 

version 11.1.1.5.0. 

4. Deploy EGRCM 8.6.4 in WLS. To do so, follow the steps described earlier in 

this chapter for a new installation. However, in the Properties and (if appropriate) 

Worklist tabs of the GRC Manage Application Configuration page, reuse the 

values that had been entered for the 8.6.3.4000 deployment.  
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3 

Integrating GRCI with EGRCM 

If you intend to license GRCI for use with EGRCM, complete the procedures 

described in this chapter.  

In very broad terms, the GRCI integration is a two-step process: 

• You are assumed to have created a Data Analytics (DA) schema for use by 

GRCI (see “Creating GRC and DA Schemas,” page 1-3). Set up connections to 

the DA schema in an EGRCM Analytics page. 

• GRCI makes use of Oracle Business Intelligence Enterprise Edition (OBIEE), 

so you need to set up OBIEE for use with GRC. 

Connecting to the DA Schema 

The GRC schema used by EGRCM supplies data to the DA schema used by GRCI. 

For this to happen, you need to enter connectivity information in EGRCM.  

1. Log on to EGRCM (see step 1 of “EGRCM Configuration” on page 2-13).  

Select Navigator → Tools → Setup and Administration → Manage Application 

Configurations. 

2. In the Manage Application Configurations page, select the Analytics tab. 

3. In the Data Analytics Configuration section, enter values that identify the DA 

schema you set up in “Creating GRC and DA Schemas” (page 1-3). 

• User Name: Supply the user name for the DA database. 

• Password: Supply the password for the DA database. 

• Confirm Password: Re-enter the password for the DA database. 

• Port Number: Supply the port number at which the database server 

communicates with other applications. 

• Service Identifier: Supply the service identifier (SID) for the database 

server. 

• Server Name: Supply the fully qualified domain name of the database server. 
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4. Select the Update Data Analytics When Analysis Is Run check box to update 

the data analytics schema each time evaluations take place in EGRCM. (Or, 

clear the check box to prevent the data analytics schema from being updated.) 

5. When you finish entering property values, click on Actions → Save. GRC tests 

the values you’ve entered and, if they are valid, saves them. (If any are invalid, 

an error message instructs you to re-enter them.) 

6. Look for the prompt, “Successfully saved configuration values.” When you see 

it, restart the server. 

When the Data Analytics schema is created, a period of approximately fifteen minutes 

needs to pass before it can read data from the GRC schema. This is a one-time issue.  

While you are configuring DA schema connectivity values, or at any time after-

ward, you can sat a schedule on which the DA schema is refreshed — on which the 

DA schema reads data from the GRC schema. To do so: 

1. Select the Analytics tab of the Manage Applications Configurations page.  

2. Click on the Schedule Data Analytics Update button.  

3. A Schedule Parameter dialog opens. Enter values that set the name of the sched-

ule, its start date and time, the regularity with which the DA schema should be 

refreshed, and an end date (if any). Then click on the Schedule button.  

4. Click on Actions → Save.  

Setting Up OBIEE in GRC 

Before you begin, ensure that the Administration Server and (if one was created) the 

managed server for your WebLogic domain are shut down. (See steps 7 and 8 on 

page 2-4.) Ensure that a VNC server is running, and use a VNC client of your choosing 

to start a VNC session.  

Perform the OBIEE installation on the GRC host — the machine on which you 

installed EGRCM in Chapter 2. 

Prepare Files 

Locate the file grc864_obiee.zip in your <grc_stage> directory (see “Downloading 

Files,” page 2-2), and extract its contents in <MW_HOME> (which, as noted in Chap-

ter 2, represents the full path to the home directory of your middleware installation). 

This overwrites some files under the oracle_common directory. 

Then, in <MW_HOME> execute a script extracted from grc864_obiee.zip: 

./grc_obiee_update.sh <MW_HOME> <HOST> <HOST_IP> <HOST_PORT> 

<JAVA_HOME> <DB_HOST> <DB_PORT> <DB_NAME> <SID> <DOMAIN> 

In addition to <MW_HOME>, parameters include the following: 

• <HOST>: The fully qualified domain name for the GRC host — the machine on 

which you installed EGRCM in Chapter 2. 

• <HOST_IP>: The IP address of <HOST>. 

• <HOST_PORT>: the port number configured for your Administration Server (see 

step 7 on page 2-4.) 
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• <JAVA_HOME>:The full path to the Java deployment used for the middleware 

installation (the JDK instance you confirmed to be in the path to install and run 

WebLogic under “Initial WebLogic Installation” on page 2-3.) 

• <DB_HOST>:The fully qualified domain name for the machine that hosts the 

GRC database. 

• <DB_PORT>: The port number at which the GRC database communicates with 

other applications. 

• <DB_NAME>: The fully qualified service name for the GRC database. 

• <SID>: The service identifier for the GRC database server, as configured in the 

tnsnames.ora file. 

• <DOMAIN>: The full path to the WebLogic domain you created for EGRCM: 

<MW_HOME>/user_projects/domains/<grc_domain> (in which <grc_domain> 

represents the WebLogic domain name; see step 2 on page 2-4.) 

Create a BI Schema 

Navigate to <RCU_HOME>/bin (in which <RCU_HOME> represents the highest-level 

directory in which RCU components exist). Then execute the following script: 

<MW_HOME>/rcu_createOBIEE.sh 

As you run the script, respond to a prompt for the SYS user password. Respond also 

to prompts to create passwords for BIPLATFORM and MDS; for each of these, use the 

value grc. 

Copy Additional Files 

Your <grc_stage> directory contains the file grc-reportservices-8.6.4-SNAPSHOT-

obiee.artifacts.zip. (It was included in grc_864.zip; see “Downloading Files” on 

page 2-2). Create a temp directory, and extract the contents of grc-reportservices-

8.6.4-SNAPSHOT-obiee.artifacts.zip into the temp directory . Then: 

• Copy temp/repository/* to <MW_HOME>/instances/instance1/bifoundation/ 

OracleBIServerComponent/coreapplication_obis1/repository. 

• Copy temp/Webcat/* to <MW_HOME>/instances/instance1/bifoundation/ 

OracleBIPresentationServicesComponent/coreapplication_obips1/catalog. Be 

sure to use the –R option of the copy command.  

(When you finish these copy operations, don’t delete the temp directory; you’ll need 

one of its files later.) 

Extend Domain 

Navigate to <MW_HOME>/Oracle_BI1/common/bin, and run config.sh. As you do: 

1. Select Extend an existing WebLogic domain. 

2. Click Next. 

3. Select to extend the <MW_HOME>/user_projects/domains/<grc_domain> 

directory.  
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4. Click Next. 

5. Select Oracle BI Enterprise Edition. 

6. Click Next. 

7. Select OWSM MDS Schema and enter the following values: 

• Vender: Oracle 

• DBMS/Service: The fully qualified service name for the GRC database. 

• Driver: Accept the default value.  

• Host Name: The fully qualified domain name for the machine that hosts the 

GRC database. 

• Schema Owner: EGRCM_MDS 

• Schema Password: grc 

• Port: The port number at which the GRC database communicates with other 

applications. 

8. Unselect OWSM MDS Schema and select EPM Schema. Enter the following 

values: 

• Vender: Oracle 

• DBMS/Service: The fully qualified service name for the GRC database. 

• Driver: Accept the default value.  

• Host Name: The fully qualified domain name for the machine that hosts the 

GRC database. 

• Schema Owner: EGRCM_BIPLATFORM 

• Schema Password: grc 

• Port: The port number at which the GRC database communicates with other 

applications. 

9. Click Next. 

10. If the connection tests for both schemas succeed, click Next. Otherwise, click 

Previous and enter correct values. 

11. Select Managed Servers, Clusters and Machines. 

12. Click Next. 

13. Modify the Listen address field to the IP address of the machine on which you 

installed EGRCM. 

14. Click Next. 

15. Click Next. 

16. Click Next. 

17. Click Extend. 

18. Click Done. 
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Update More Files 

Complete five procedures to update files: 

First, edit the file <MW_HOME>/user_projects/domains/<grc_domain>/config/ 

fmwconfig/system-jazn-data.xml: 

1. Copy the contents of the file <MW_HOME>/Oracle_BI1/AddToPolicy.txt. 

2. In system-jazn-data.xml, locate the <policy-store> and </policy-store> tags. 

Paste the copied AddToPolicy contents between the tags. 

3. Copy the contents of the file <MW_HOME>/Oracle_BI1/AddToJaznPolicy.txt. 

4. In system-jazn-data.xml, locate the </jazn-policy>  tag at the end of the file. 

Paste the copied AddToJaznPolicy contents before the </jazn-policy> tag.  

5. Save and exit system-jazn-data.xml. 

Second, copy <MW_HOME>/Oracle_BI1/cwallet.sso to <MW_HOME>/user_projects/ 

domains/<grc_domain>/config/fmwconfig. 

Third, if you have not already done so, edit boot.properties files. (You have already 

edited these files if you installed EGRCM to integrate with OID LDAP; see step 14 

on page 2-7. If so, use these files as you edited them earlier.) 

If you have not edited these files yet, there are up to two of them, one for the GRC 

Administration Server and (if you use SOA) one for the SOA Server. If they do not 

already exist in these locations, create either the one for the Administration Server 

(if you do not use SOA) or both (if you use SOA): 

• For the Administration Server, <MW_HOME>/user_projects_domains/ 

<grc_domain>/servers/AdminServer/security/boot.properties 

• For the SOA Server, <MW_HOME>/user_projects_domains/<grc_domain>/ 

servers/<SoaServerName>/security/boot.properties 

The same edits apply to both: Set a username value equal to the administrator user 

name for your WebLogic installation, and a password value equal to that user’s 

password. (You specified these as you created a WebLogic domain; see step 3 on 

page 2-4.)  

Fourth, replace an existing biee-domain.xml file with a new one: 

1. Make a backup copy of <MW_HOME>/user_projects/domains/<grc_domain>/ 

config/fmwconfig/biee-domain.xml. 

2. Copy <MW_HOME>/Oracle_BI1/biee-domain.xml to <MW_HOME>/user_projects/ 

domains/<grc_domain>/config/fmwconfig. This overwrites the existing xml 

file, which you backed up in step 1. 

Fifth, edit an instanceconfig.xml file: 

1. Navigate to <MW_HOME>/instances/instance1/config/OracleBIPresentationServices  

Component/coreapplication_obips1/instanceconfig.xml. Open the file in a text 

editor. 

2. Insert the following immediately after the < Security> tag: 

<InIFrameRenderingMode>allow</InIFrameRenderingMode> 

3. Save the file and quit it.  



 

3-6 Oracle Governance, Risk and Compliance Installation Guide 

Configure the WebLogic Server 

Complete the following steps to perform WebLogic Server configuration: 

1. Go to <MW_HOME>/user-projects/domains/<grc_domain>/bin. 

2. Enter this command: 

nohup ./startWebLogic.sh > wls.log & 

3. Watch (tail –f) wls.log. 

4. When the log indicates the server is in RUNNING MODE, open a browser and log 

in to the WebLogic Server Administration Console at 

http://host:port/console 

In this URL, replace host with the FQDN of your GRC server, and port with the 

number you selected for the WebLogic Administration Server. (See step 7 of “Cre-

ating a WebLogic Domain” on page 2-4.) 

Log in with your WebLogic Administration username and password. (See step 3 

on page 2-4.) 

5. From the left menu, select Security Realms. 

6. Click on myrealm. 

7. Click on the Users and Groups tab on top. 

8. From the left side, click on the Lock & Edit button. 

9. Click New to create a new user. Name the user BISystemUser. Enter any pass-

word, but make note of it because you will need it later. Click OK to save the 

user. 

10. Click on the user you just created, and select the Groups tab from the top. 

11. Add the Administrators parent group to this user and select Save. 

12. From the top breadcrumb, click on Users and Groups. 

13. Click on the Groups tab. 

14. Click New to create a new group. Name the group BIAdministrators. Click on 

OK to save the group. 

15. Use the process described in step 14 to create two more groups, named 

BIAuthors and BIConsumers. 

16. When all three groups are created and you are on the Groups tab, click on the 

BIAuthors group. 

17. Click on the Membership tab. 

18. Add the BIConsumers group as the parent group and select Save. 

19. From the top breadcrumb, click on Users and Groups. 

20. In a similar way, add BIAuthors as the parent group of BIAdministrators. 

21. From the top breadcrumb, click on Users and Groups. 

22. Click on the Users tab. 
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23. Click on the weblogic user. 

24. Click on the Groups tab and add the BIAdministrators group as one of the 

parent groups. Click Save. 

25. From the left menu click on Services and then Data Sources. 

26. Click on the New button and choose Generic Data Sources. 

27. Name the data source bip_datasource. Then, for JNDI name, enter 

jdbc/bip_datasource. 

28. Click Next. 

29. Click Next. 

30. Click Next. 

31. Enter the following values: 

• Database Name: The service identifier (SID) for the GRC database server, 

as configured in the tnsnames.ora file. 

• Host Name: The fully qualified domain name for the machine that hosts the 

GRC database. 

• Port: The port number at which the GRC database communicates with other 

applications. 

• Database User Name: EGRCM_BIPLATFORM 

• Password: grc 

• Confirm Password: grc 

32. Click Next. 

33. Click Test Configuration; click Next if the test succeeds. 

34. Select bi_cluster as Target. 

35. Click Finish. 

36. From the Change Center on the left, click Activate Changes. 

37. Click Lock & Edit. 

38. Click on the New button and choose Generic Data Sources. 

39. Name the data source rtd_datasource. Then, for JNDI name, enter 

jdbc/rtd_datasource. 

40. Click Next. 

41. Click Next. 

42. Click Next. 

43. Enter the following values: 

• Database Name: The service identifier (SID) for the GRC database server, 

as configured in the tnsnames.ora file. 

• Host Name: The fully qualified domain name for the machine that hosts the 

GRC database. 



 

3-8 Oracle Governance, Risk and Compliance Installation Guide 

• Port: The port number at which the GRC database communicates with other 

applications. 

• Database User Name: EGRCM_BIPLATFORM 

• Password: grc 

• Confirm Password: grc 

44. Click Next. 

45. Click Test Configuration; click Next if the test succeeds. 

46. Select bi_cluster as Target. 

47. Click Finish. 

48. From the Change Center on the left, click Activate Changes. 

49. Navigate to http://host:port/em, in which (once again), host is the FQDN of your 

GRC server, and port is the number you selected for the WebLogic Administra-

tion Server. (See step 7 of “Creating a WebLogic Domain” on page 2-4.) Log in 

with your WebLogic Administration username and password. (See step 3 on 

page 2-4.) 

50. From the left menu, expand Farm_<grc_domain> → WebLogic Domain, and 

right click on your <grc_domain>. 

51. Select Security → Credentials. 

52. Expand oracle.bi.system. 

53. Select system.user and click on the Edit button. 

54. Update the password to the value you chose in step 9 (page 3-6) and click OK. 

OPMN Configuration 

Complete these steps to perform OPMN configuration: 

1. Go to <MW_HOME>/user_projects/domains/<grc_domain>/bin. 

2. Enter these commands: 

.stopWebLogic.sh 

nohup ./startWebLogic.sh > wls.log & 

3. Watch (tail –f) wls.log. 

4. When the log indicates the server is in RUNNING MODE, press Ctrl+C. Then run: 

nohup ./startManagedWebLogic.sh bi_server1 

Enter your WebLogic Administration username and password. (See step 3 on 

page 2-4.) 

5. When the Managed Server is in RUNNING MODE, open another terminal window 

and go to <MW_HOME>/instances/instance1/bin. 

6. Execute opmnctl registerinstance. When prompted, enter your WebLogic 

password. 

7. Go to <MW_HOME>/user_projects/domains/<grc_domain>/bin. 



 

 Integrating GRCI with EGRCM 3-9 

8. Enter these commands: 

./stopManagedWebLogic.sh bi_server1 

./stopWebLogic.sh 

9. When the Administration Server has finished shutting down, run: 

nohup ./startWebLogic.sh > wls.log & 

10. Watch (tail –f) wls.log. 

11. When the Administration Server is in RUNNING MODE, press Ctrl+C. Then run: 

./startManagedWebLogic.sh bi_server1 

Enter your WebLogic Administration username and password.  

12. When the Managed Server is in RUNNING MODE, open another terminal window 

and go to <MW_HOME>/instances/instance1/bin. 

13. Enter this command: 

./opmnctl startall 

If all is as it should be, you will see 4 of 5 processes started. If you don’t see 

this status, you can further verify this by running opmnctl status.  

GRC Intelligence Configuration 

Complete these steps to configure your GRC Intelligence instance: 

1. Log on to EGRCM (see step 1 of “EGRCM Configuration” on page 2-13).  

2. In the Navigation pane, select Manage Application Configurations from the 

Administration list of tasks.  

3. In the Manage Application Configuration page, select the Analytics tab. 

4. In the GRC Intelligence section, supply the following values: 

• OBIEE Server Username: The username value configured for the Weblogic 

Administration Server (see step 3 on page 2-4). 

• OBIEE Server Password: The password value configured for the Weblogic 

Administration Server (see step 3 on page 2-4). 

• OBIEE Server Port: 9704 

• OBIEE Server Host: The fully qualified domain name for the GRC host — 

the machine on which you installed EGRCM in Chapter 2. 

• Root Context: analytics 

Leave the Enable SSL Authentication check box unchecked.  

5. Select Actions > Save, then exit the configuration page. 

Repository Configuration 

Modify a file called GRCDiagnostic.rpd, and then use it to configure repositories. 

To do so, you must use a tool that runs only on a Windows-based computer. 
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Throughout this section (as before), host is the FQDN of your GRC server, and port 

is the number you selected for the WebLogic Administration Server. (See step 7 of 

“Creating a WebLogic Domain” on page 2-4.)  

1. On a Windows machine, open an FTP client and connect to host. Navigate to 

<MW_HOME>/instances/instance1/bifoundation/OracleBIServerComponent/ 

coreapplication_obis1/repository. From that directory, download the file 

GRCDiagnostic.rpd to your Windows machine. Then close the FTD client. 

2. On the Windows machine, go to http://www.oracle.com/technetwork/ 

middleware/bi-enterprise-edition/downloads/bus-intelligence-11g-165436.html. 

From that site, download and install Oracle Business Intelligence Developer 

Client Tools Installer (11.1.1.5.0). 

3. When the installation is complete, ODBC Data Source Administrator opens. 

Press Cancel to close it (it is not needed for this procedure.) 

4. Open the Oracle BI Administration Tool: From the Start menu, navigate to 

Oracle Business Intelligence Enterprise Edition Plus Client → Administration.  

5. Navigate to File → Open → Offline. Select the GRCDiagnostic.rpd file you 

downloaded in step 1. Enter Admin123 as the Repository Password. 

6. Navigate to Manage → Variables. 

• Double-click on GRI_DSN. Under Default Initializer, enter the service 

identifier (SID) for the database server, inside the single quotation marks. 

Press OK. 

• Double-click on GRI_USER_ID. Under Default Initializer, enter the schema 

name used by your DA schema, inside the single quotation marks. Press OK. 

• Close the Variable Manager. 

7. In the main window under the Physical section, right-click on GRD Diagnostics 

and select Properties. 

• Click on the Connection Pools tab and double-click on GRCI Connection 

Pool. 

• Under the Shared Logon section, enter the schema password used by your 

GRC deployment. 

• Press OK, then press OK again. 

8. Navigate to File → Save and answer No to “Do you wish to check global 

consistency?” 

9. Exit the Oracle BI Administration Tool.  

10. Still on the Windows machine, go to http://host:port/em. Log in to the host with 

your WebLogic Administration username and password. (See step 3 on page 2-4.) 

11. From the left menu, expand Farm_<grc_domain> → Business Intelligence and 

double-click on coreapplication. 

12. Select the Deployment tab. 

13. Select the Repository tab. 

14. Press Lock and Edit Configuration. 
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15. Press Close. 

16. Under Upload BI Server Repository, click the Browse button and select the 

GRCDiagnostic.rpd that you modified in steps 2 through 8. Enter Admin123 in 

both of the Repository Password and Confirm Password fields. 

17. Under BI Presentation Catalog, enter the following as the Catalog Location: 

<MW_HOME>/instances/instance1/bifoundation/OracleBIPresentationServices 

Component/coreapplication_obips1/catalog/GRCDWebcat 

18. Click on the Apply button. 

19. Click on the Activate Changes button on top. 

20. Click on Close after the changes are activated. 

21. Press the Restart to apply recent changes button on top. 

22. Click on the Restart button. 

23. Select Yes. 

24. Click on Close after the restart completes. 

Test the Installation 

To test the installation, open a browser and got to http://host:9704/analytics (in 

which host is the FQDN of your GRC server). Log in with your WebLogic Admin-

istration username and password. (See step 3 on page 2-4.) If you can get in, the 

installation has been successful. 
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Deploying a VM Image of GRC 

Rather than perform a conventional GRC installation, you can deploy a GRC image 

configured in advance by Oracle. Use Oracle VM Server to deploy the image.  

The image is an instance of either EGRCM running with WebLogic. For EGRCM, 

the image is initially configured to run without SOA; however, a SOA instance is 

included, and once deployment is complete you can configure the image to use SOA 

worklists. All other required elements, such as operating system and database, are 

included in the image. The database includes both a GRC schema (which serves the 

application itself) and a Data Analytics schema (for use with GRCI). 

Deploying a GRC Distribution 

To deploy an Oracle GRC distribution for Oracle VM Server: 

1. Obtain and install Oracle VM Manager and Oracle VM Server 2.2. 

2. Add the hostname of the machine hosting Oracle VM Server to the “server 

pool” in Oracle VM Manager. 

3. Extract an Oracle GRC Distribution into the “running_pool” directory on the 

Oracle VM Server. Use grcm.tar.gz if you want to run Enterprise Governance, 

Risk and Compliance Manager 

4. Open the file vm.cfg in a text editor. (It’s located in the directory extracted from 

the Oracle GRC Distribution.) In it, locate the “disk” line. Edit this line to contain 

the path to system.img (which resides in the same directory as vm.cfg, extracted 

from the Oracle GRC Distribution).  

5. Log in to Oracle VM Manager. On the Resources tab, select Virtual Machine 

Images. 

6. Click on the Import button. 

7. Select the second option, “Select from Server Pool (Discover and register).” 

Then click Next. 
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8. Ensure your VM is selected in a Virtual Machine Image Name drop-down field. 

(Your VM is stored in a subdirectory of the “running_pool” directory, and its 

name is the same as the name of this subdirectory.) Then select and fill in other 

fields. (Note: For operating system, select Oracle Enterprise Linux 5 64-bit.) 

Click the Next button. 

9. A confirmation page appears. Review it and (assuming values are correct) click 

on the Confirm button. The Virtual Machine Images entry page reappears. 

10. Click on the Approve button. Another confirmation page appears. Review it and 

(assuming values are correct) click on the Confirm button. 

11. You should now see the VM in a powered off state. Click the Power On button 

and enter “OS in Single User Mode.” 

12. Once in Single User Mode, change the “root” user password and edit the net-

work configurations to make the VM accessible on your network.  

Change the hostname and IP of the VM in the following files: 

/etc/hosts/ 

/etc/resolv.conf 

/etc/sysconfig/network 

/etc/sysconfig/network-scripts/ifcfg-eth0 

Change the hostname and IP of the DB in the following files: 

/u01/app/oracle/product/11.2.0/db/network/admin/listener.ora 

/u01/app/oracle/product/11.2.0/db/network/admin/tnsnames.ora 

When all updates are completed, restart the instance. 

13. Once the startup is completed, you should be able to log into the instance as the 

“root” user or the “oracle” user. All applications are owned by the oracle user.  

Users and Passwords 

Default usernames and passwords within a GRC image include the following: 

• Oracle Database: sys/manager 

• Oracle Database: system/manager 

• OS (root user): root/welcome 

• OS (oracle user): oracle/welcome 

• WebLogic Administration Server: weblogic/welcome1 

• SOA (soa_server1) Managed Server: weblogic/welcome1 

• Oracle WebLogic Server Console: weblogic/welcome1 

• Oracle WebLogic Server Enterprise Manager: weblogic/welcome1 

• GRC Schema: grc_user/grc_password 

• GRC Data Analytics Schema: grc_user_da/grc_password 
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Log File Locations 

Default locations of log files within a GRC image include the following: 

• Oracle Weblogic Server - AdminServer (nohup): 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/bin/wls.log 

• Oracle Weblogic Server - SOA (soa_server1) Managed Server (nohup): 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/bin/soa.log 

• Oracle Weblogic Server - AdminServer: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/servers/Admin

Server/logs 

• Oracle Weblogic Server - SOA (soa_server1) Managed Server: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/servers/soa_ 

server1/logs 

• GRC Log: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/servers/Admin

Server/stage/grc864/grc864/grc/log/grc.log 

Starting a GRC Distribution 

To start an Oracle GRC distribution for Oracle VM Server: 

1. Log into the instance as the oracle user. 

2. Set the ORACLE_HOME environment variable: 

export ORACLE_HOME=/u01/app/oracle/product/11.2.0/db 

3. Set the ORACLE_SID environment variable: 

export ORACLE_SID=orcl 

4. Add ORACLE_HOME/bin to the PATH: 

export PATH=$ORACLE_HOME/bin:$PATH 

5. Use SqlPlus to start the Oracle database. For example: 

sqlplus /nolog 

SQL> connect / as sysdba 

SQL> startup 

SQL> exit 

6. Start the Oracle Database Listener: 

lsnrctl start 

7. Set your path to the following: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/ 

bin 

8. Start the WebLogic Administration Server: 

nohup ./startWeblogic.sh > wls.log & 

9. Optionally, start the WebLogic SOA Managed Server (soa_server1).  

nohup ./startManagedWeblogic.sh soa_server1 > soa.log & 
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10. Verify that WebLogic and (if applicable) SOA are available by connecting to 

the Oracle WebLogic Server Enterprise Manager. (Replace <hostname> with 

the value you created in step 12 of “Deploying a GRC Distribution,” page 4-2.) 

http://<hostname>:7001/em 

11. Verify that the GRC application (grc864) is available by connecting to the 

Oracle WebLogic Server Console. (Replace <hostname> with the value you 

created in step 12 of “Deploying a GRC Distribution,” page 4-2.) 

http://<hostname>:7001/console 

12. Logon to the GRC application. (Replace <hostname> with the value you created 

in step 12 of “Deploying a GRC Distribution,” page 4-2.) 

http://<hostname>:7001/grc 

Stopping a GRC Distribution 

To stop an Oracle GRC distribution for Oracle VM Server: 

1. Log into the instance as the oracle user. 

2. Set the ORACLE_HOME environment variable: 

export ORACLE_HOME=/u01/app/oracle/product/11.2.0/db 

3. Set the ORACLE_SID environment variable: 

export ORACLE_SID=orcl 

4. Add ORACLE_HOME/bin to the PATH: 

export PATH=$ORACLE_HOME/bin:$PATH 

5. Set your path to the following: 

/u01/app/Oracle/Middleware/user_projects/domains/grc_domain/ 

bin 

6. If the WebLogic SOA Managed Server (soa_server1) is running, stop it.  

./stopManagedWeblogic.sh soa_server1 

7. Stop the WebLogic Administration Server: 

./stopWeblogic.sh 

8. Stop the Oracle Database Listener 

lsnrctl stop 

9. Use SqlPlus to start the Oracle database. For example: 

sqlplus /nolog 

SQL> connect / as sysdba 

SQL> shutdown immediate 

SQL> exit 
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